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Introduction 

This documentation is provided to you, the service technician, with all information necessary to install, 
configure and calibrate the ViZion DR+ 1417V2 Wireless Panel. For more detailed information on the 
operation and specifications of your wireless detector, please review the following documentation:  
 
Manual References:  
 
• 059-201-04 Mars1417V2 User Manual A0.pdf 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Only qualified service personnel should attempt 

to install, modify, service or operate the ViZion 

DR+ Wireless Panel detector. 
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Hardware Overview and Installation 

1 ViZion DR+ 1417V2 Wireless 

Panel Hardware 
The following equipment is required to properly 

install and implement your ViZion DR+ system. 

1.1 Passive Installation 

• ViZion DR+ 1417V2 Wireless Panel 

Detector 

 

• ASUS Dual-Band Wi-Fi Gigabit AP 

 

• 75 ft. Cat5 Ethernet Cable 

 

• Acquisition PC Desktop or Laptop 

(Windows 10) 

 

 

1.2 Integrated Installation 

The following additional equipment is required 

for integration with a generator. 

• G.I.P.S. Box 

 

• Power Supply Synchronization Cable 

 

• 50 ft. Female-to-Female Serial Cable 

 

• Tripp Lite USB-to-Serial Adapter 
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1.3 ViZion DR+ 1417V2 Wireless 

Panel Detector (Mars1417V2) 

The following equipment is required for 

integration with a generator. 

 

 

 

1.3.1 Connector Ports and Control Panel 

 

A. DC Jack: 24V DC input  

B. Ethernet interface: Link cable jack  

C. LED indicators: Indicates the state of the 
detector  

D. Power button: Detector power ON/OFF 
button  

E. Infrared window: Infrared device sensor  

F. Antenna: Wi-Fi antennas (three)  

G. Reserved  

H. Maintenance cover: For service engineer to 
maintenance  

I. Battery lock: The lock button for detaching 
battery  

J. Detector label: Serial number and product 
information  

 

1.3.2 LED Indicators 

 

1. Battery Indicator:  

• Green: battery charge is < 10%  

• Orange: battery charge is ≥ 10%  

2. Link Indicator:  

• Blue (solid): wireless connection is 
connected  

• Blue (blinking): wireless connection is 
ready, but not connected  

• Green (solid): wired connection is 
connected  

• Green (blinking): panel initialization  

3. Status Indicator:  

• Green (solid): data transmission  

• Orange (solid): panel initialization  

• Orange (blinking): fatal error 
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1.4 G.I.P.S. Box (Generator 

Integration Power Supply) 

 

 

1. X-Ray Interface (connect only one) 

• 12-24 VDC Digital 

• 120 VAC Bucky 

2. AC Power port (Three-Prong) 

3. LED Lights (Power / System / Status) 

4. Computer Serial port (male) 

5. Panel Power (Panel 1 and Panel 2) 

 

1.5 Synchronization, Ethernet and 

Power Cables 

Your ViZion DR+ wireless detector includes the 

following accessories:  

• 75 ft. Cat5 Ethernet Cable 

• 50 ft. Female-to-Female Serial Cable 

• Tripp Lite USB-to-Serial Adapter 

• Power Supply Synchronization Cable 

 

 

 

 

 

1.5.1 Synchronization Cable 

Review the available signal wires in the 
following figures prior to connecting the 
generator synchronization cable.  
 
 

Note: depending on generator setup, you 

may need to cut off the DB9 end 

and wire directly. 
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1.6 ViZion DR+ Wireless Panel 

Battery Charger 

 

 

A. Battery interface: 8-pin battery connector  

B. Capacity indicator: Charged capacity 
percentage of inserted battery from ≤ 30% 
up to 100% (Figure 9)  

C. Power indicator: Green light displays when 
power is on  

D. Hand pull position  

E. Limit ball plug  

F. DC Jack (24V DC input)  
 

 

 

 

 

 

 

1.6.1 Battery Charger Capacity Indicators 

 

 

1.6.2 Connector Ports  
It is alternatively possible to trickle charge the 
battery inside the panel, by connecting the DC 
power cable from the DC medical adapter 
power supply to the DC input of the detector.  

To preconfigure the panel for alternate wireless 

connection modes and panel calibration, 

connect the Link cable to the mini-HDMI 

ethernet interface of the detector for a wired 

network connection. 
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1.7 Additional Components 

• Battery Pack (2) 

 

• DC Medical Adapter for Detector and 

Battery Charger 

 

• AC Power Cable 

 

• DC Power Cable 

 

• Link Cable 

 

• ASUS Dual-Band Wireless USB Adapter 

(option for mobile) 

 

• TP-Link AC750 Wireless Travel Router 

Access Point (option for mobile) 

 

2 Hardware Installation 
Now that you have verified the hardware, the 

next step is to connect all of the devices 

together. If you are uncertain whether or not 

you have all required hardware, please consult 

the equipment list, which can be located at the 

beginning of Section 1. 

The following sections provide step-by-step 

instructions to complete the hardware 

installation. The connections between the 

various devices are more or less 

straightforward; however, only a qualified 

service technician should attempt to connect 

the synchronization cable to the generator and 

bucky interface. 

The following diagrams illustrate the completed 

hardware installation. Note that this diagram 

does not take into account any connection to a 

corporate LAN. 

2.1 Fixed Room Hardware 

Installation 

The following diagram is an example of an 

Integrated hardware installation: 

 

The following diagram is an example of a 

Passive hardware installation: 
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2.1.1 Connecting the Synchronization Cable 

The power supply generator synchronization 

cable enables communication between the 

ViZion DR+ wireless detector and the X-ray 

generator to take place. One end of this cable 

connects directly to the G.I.P.S. box. The other 

end of the cable connects to the X-ray 

generator. Depending on the manufacturer and 

model of your X-ray generator, your 

synchronization cable may need to be retro-

fitted with the appropriate adapter. 

Connect the power supply synchronization 

cable. 

1. Connect power supply synchronization 

cable to Port 1 (either A or B depending 

on the expected voltage signal) on the 

G.I.P.S. box. 

2. Connect the other end of the 

synchronization cable to your 

Generator (remote triggering device or 

bucky interface). 

 

Note: You can find detailed information 

on connecting your cable to a 

specific generator in the appropriate 

appendix in the Engineering folder 

located on the desktop of the Ultra 

workstation. 

 

2.1.2 Connecting the G.I.P.S Box to the 

Acquisition PC 

To connect the G.I.P.S. box to the acquisition 

PC for integration: 

1. Connect the 50’ F-to-F serial cable to 

Port 4 on the G.I.P.S. box. 

2. Connect the other end of the 50’ serial 

cable to the serial-to-USB adapter. 

3. Plug the USB adapter end into one of 

the USB ports on the back of the 

acquisition PC. 

 

2.1.3 Connecting the Acquisition PC to the 

Wireless Access Point 

To connect the ASUS AP to the acquisition PC: 

1. Connect the 75’ Cat5 ethernet cable to 

one of the Yellow Ports on the back of 

the ASUS AP. 

2. Connect the other end of the ethernet 

cable to the Intel Gigabit CT Network 

Adapter on the acquisition PC. 

 

2.2 Mobile Hardware Installation 

Begin by taking an inventory of the additional 

required equipment, which can be found at the 

end of Section 1. 

2.2.1 SourceRay SR-130 Mobile X-Ray Unit 

• Side view 

 

• Console view 
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2.2.2 SourceRay SR-130 Accessory Cables 

1. Connect the hand switch cable to the 

Generator Console (or directly to the 

tube head, depending on model X-ray 

unit being used). 

 

2. The power cable connects the X-ray unit 

to a grounded wall outlet. 

 

 

3 Network Installation 

3.1 Fixed Room Network 

Configuration 

After installing the hardware, configure the 

network address on the Intel Gigabit CT PCI-e 

network adapter (the add-on network card on 

the acquisition PC).  

 

Note: the ViZion DR+ Wireless panel, 

acquisition PC, and ASUS access 

point, all come preconfigured. 

These instructions show how to 

configure the devices, as needed. 

 

The goal is to ensure that each device can 

communicate with one another, which requires 

that they are configured on the same network 

segment. 

 

 

The following network equipment is required for 

fixed room environments:  

• ASUS Dual-Band Wi-Fi Gigabit AP 

 

• 75’ Cat5 Ethernet Cable 

 

• Link Cable (to preconfigure the ViZion 

DR+ 1417V2 wireless panel) 

 

You must first configure the IP address on the 

acquisition PC.  

By default, the ViZion DR+ 1417V2 wireless 

panel will have an IP address hardcoded to 

192.168.8.8. The ASUS AP should be 

configured with an IP address of 192.168.8.50. 

The CT network adapter on the PC should be 

configured with an IP address of 192.168.8.188. 

The following diagram illustrates a fixed room 

network environment. 
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3.1.1 Configure IP Address on the PC  

1. From Control Panel, select Network 

Connections, and right-click on the CT 

network adapter and select Properties. 

2. Select Internet Protocol Version 4 

(TCP/IPv4) and click Properties. 

3. Select Use the following IP address 

radio button. 

4. Enter the following settings: 

• IP address 192.168.8.188 

• Subnet mask 255.255.255.0 

5. Click OK to save the changes. 

 

6. Connect the ethernet RJ-45 end of the 

Link cable to one of the Yellow ports 

on the ASUS Access Point. 

7. Connect the mini-HDMI end of the Link 

cable to the Link port on the side of the 

panel. 

 

8. Proceed to Section 4. 

3.2 Mobile Network Configuration 

For mobile environments, the panel can be put 

into Client mode (to connect the laptop to an 

external access point device, that the panel will 

connect to [recommended method]), or put in 

AP mode (to allow the panel to broadcast a 

wireless network, for the laptop to connect to 

[alternative method). 

 

3.2.1 ViZion DR+ 1417V2 Wireless Panel in 

Client Mode (Recommended method) 

When the panel is in Client mode, the panel 

will connect automatically to the external TP-

Link Access Point, using the laptop’s LAN 

Ethernet adapter. For your internet connection, 

you will connect to any available Wi-Fi network 

using the laptop’s internal wireless adapter. 

Equipment required for Client mode:  

• TP-Link AC750 Wireless Travel Router 

Access Point 

 

• Link Cable (to preconfigure the panel’s 

wireless settings) 

 

 

Note: you will configure the panel into 

Client mode later in Section 4.7.2, 

once you get to that part of the 

installation.  

 

For now, we will configure the LAN Ethernet 

network adapter (without the TP-link AP 

connected), so the panel communicates wired 

via the Link cable during the installation. 
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1. From Control Panel, select Network 

Connections, and right-click on the Intel 

Local Area Network Ethernet adapter 

and select Properties. 

2. Select Internet Protocol Version 4 

(TCP/IPv4) and click Properties. 

3. Select Use the following IP address 

radio button. 

4. Enter the following settings: 

• IP address 192.168.8.188 

• Subnet mask 255.255.255.0 

5. Click OK to save the changes. 

 

6. Connect the ethernet RJ-45 end of the 

Link cable to the LAN Ethernet port on 

the laptop computer. 

7. Connect the mini-HDMI end of the Link 

cable to the Link port on the side of the 

panel. 

 

 

Note: follow the instructions below 

AFTER COMPLETING ALL STEPS in 

this installation manual. For now, leave 

the Link cable connected until installation 

is complete. 

• Unpack the TP-Link AC750 AP. 

 

• Make sure the mode switch on 

the side of the access point is set 

to AP/Rng Ext/Client. 

 

• Connect the supplied USB cable 

from the laptop to the access 

point (supplies power to the 

device when plugged in). 

• Connect the supplied Cat5 

Ethernet cable from the laptop 

network adapter to the access 

point. 

 

 

8. Proceed to Section 4.  
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3.2.2 ViZion DR+ 1417V2 Wireless Panel in 

AP Mode (Alternative method) 

When the panel is in AP mode you will connect 

to the panel’s broadcasted Wi-Fi network, 

(which will be named the same as the serial 

number of the panel), using the laptop’s internal 

wireless adapter. For your internet connection, 

you will connect to any available Wi-Fi network 

using the external USB Wi-Fi adapter. 

Equipment required for AP mode:  

• ASUS Dual-Band Wi-Fi USB Adapter 

(used for the Wi-Fi Internet connection) 

 

• Link Cable (to preconfigure the panel’s 

wireless settings) 

 
 

Note: you will configure the panel into AP 

mode later in Section 4.7.3, once 

you get to that part of the 

installation.  

 

For now, during the installation, we need the 

Link cable connected to the LAN Ethernet port 

the same as in Section 3.2.1. Once the 

installation is complete, follow the steps below 

to configure the Wireless network adapter for 

use in wireless AP mode. 

1. From Control Panel, select Network 

Connections, and right-click on the Intel 

Wireless adapter and select 

Properties. 

2. Select Internet Protocol Version 4 

(TCP/IPv4) and click Properties. 

3. Select Use the following IP address 

radio button. 

 

4. Enter the following settings: 

• IP address 192.168.8.188 

• Subnet mask 255.255.255.0 

5. Click OK to save the changes. 

 

6. But during the installation, we need to 

have the Link cable connected, so follow 

the steps in Section 3.2.1 for now. 

7. Connect the ethernet RJ-45 end of the 

Link cable to the LAN Ethernet port on 

the laptop computer. 

8. Connect the mini-HDMI end of the Link 

cable to the Link port on the side of the 

panel. 

 

9. Plug in the ASUS Dual-Band Wi-Fi 

USB Adapter and wait for the drivers to 

install. This adapter will be used to 

connect to Wi-Fi networks for your 

internet connection. Driver software 

should install automatically or from CD. 

10. Proceed to Section 4. 
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Software Installation and Configuration 

4 Software Installation 

4.1 Install Microsoft Visual C++ 

Redistributable 

The ViZion DR+ 1417V2 panels require a 

prerequisite installation of Microsoft Visual 

C++ Redistributable for Visual Studio 2013, 

before installation of the Ultra software and 

latest venu driver packs. 

1. Download the 32-bit and the 64-bit 

versions of the redistributable files. You 

will need to install both versions. 

 

 

2. Start with installing the 32-bit executable 

file (x86): 

 

3. Check the box “I agree to the license 

terms and conditions and click Install. 

 

4. The installation usually takes less than 

30 seconds.  

 

5. When the installation has completed 

click Close. 

 

6. Now install the 64-bit executable file 

(x64) in the same manner. 
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4.2 Installation of Ultra Software 

All released versions of the Ultra installer files 

can be downloaded from the Konica Minolta 

FTP site. 

1. Download UAI_Setup version 4.2.9.0 

installer file to the desktop of the 

acquisition PC.  

 

2. Right-click the file and select Run as 

Administrator. 

 

3. Click Yes when prompted for “Do you 

want to backup?”. 

 

4. When the installation has completed, 

click Close. 

 

 

 

4.3 Configuration of Ultra Software 

1. Double-click on the Ultra icon to launch 

the software.  

 

2. If this is a new installation, you will be 

presented with a prompt informing you 

that this is the first time you have run 

Ultra. Click OK to proceed. 

 

3. Click the Options icon in the top corner 

of the Ultra Worklist screen. 
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4.3.1 Activate Administrative Options  

1. If this is a brand new install, the 

Configuration screen will have limited 

options, until you enter a valid 

Administrative password. 

 

2. Enter the password adc4me in the 

orange colored “Administrative” box. 

The box will change to green when a 

valid password has been entered. 

 

3. After entering the password, click Apply 

to activate all the all administrative 

configuration options. 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.2 Create Technologists (Ultra Only)  

For DR technician support purposes, add a new 

technologist for “Konica Minolta (KM)”. If you 

know the site technologist’s names, you can 

also add those at this time. 

1. Click on the Tools & Annotations tab. 

 

2. Click on the Add button under the 

“Technologists” section. 

 

3. Change the default name in the “Name” 

field to Konica Minolta and click the 

Apply button.  
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4.4 Device Licensing 

For panel, generator or positioner device 

licensing, contact Konica Minolta DR Support. 

4.5 Device Driver Installation 

The ViZion DR+ 1417V2 wireless panel uses a 

different SDK version than 1417V panels, and it 

is only compatible with Ultra UAI versions 

4.2.9.0 or higher, which introduces a selection 

for Third Generation Venu drivers.  

 

Note: the Venu Drivers Generation 

selection setting is located in the 

Developer tab under Options menu. 

ViZion DR+ 1417P, 1417P1, 1717M 

and 1717M2 panels should be 

configured to use First Generation 

Venu drivers.  

ViZion DR+ 1417V and 1717M2.5 

panels should be configured to use 

Second Generation Venu drivers. 

ViZion DR+ 1417V2 and 1012V2 

panels should be configured to use 

Third Generation Venu drivers. 

 

1. Before installing the new venu driver 

pack, double-click on the Konica 

Minolta logo, located in the bottom left 

corner of the Options menu. This action 

will display the Developer tab in the 

upper right corner. 

 

 

 

 

 

 

2. Select the Developer tab and select the 

drop down next to Venu Drivers 

Generation and select Third. 

 

3. Click Apply, and then click OK to the 

message that pops up. 

 

4. Click OK to exit Option menu, and then 

click the Log Off icon in the top right 

corner to exit Ultra. 

 

5. Confirm by clicking the Log Off button. 

 

4. Double-click on the Ultra icon to 

relaunch the software.  
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5. Click the Options icon in the top corner 

of the Ultra Worklist screen. 

 

6. Select the Device Configurations tab 

and select the Launch button. 

 

7. This will launch the Device Manager 

window. Click the Shutdown Devices 

button. 

 

8. Wait until the Devices status changes 

from Initialized to Shutdown. 

 

 

 

 

9. After shutting down devices, check the 

boxes for Download Driver and Install 

Driver next to Venu DR (in the middle of 

the Device Manager window). 

 

10. Click the Perform Driver Actions 

button and it will proceed to download 

the venu driver pack. 

11. Click Next for the WinPcap installation 

wizard. 

 

12. Click Next. 
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13. Click on I Agree. 

 

14. Uncheck the box for “Automatically start 

the WinPcap driver at boot time” and 

then click Install. 

 

15. Click Finish and wait for the driver 

installation to complete. 

 

 

 

16. Once completed you should verify that 

Venu installed. 

 
 

Note: if it shows “Venu failed”, instead of 

"Venu Installed”, the download did 

not fully transfer or got corrupted 

during download. Check to make 

sure Windows Firewall is disabled 

and AV is excluding the C:\opal 

folder. Then rerun the driver 

download and install again. 

 

17. Click Initialize Devices and exit the 

Device Manager window by clicking the 

red X in the top corner. 

 

18. The Devices status will change from 

Shutdown to Initialized when 

completed.  
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4.6 Device Pool Configuration 

After successful driver pack installation, it is 

time to configure the device settings for the 

ViZion DR+ 1417V2 wireless panel.  

Before performing the following steps, make 

sure the wireless panel is powered on, with 

a fully charged battery, and connected with 

the Link cable. 

1. After closing the Device Manager 

window you should be back at the 

Options menu with the Device 

Configurations tab selected. 

2. Click to highlight DEFAULT under the 

“Configuration Pool” section. 

 

3. Click on ViZion DR+ and the panel 

device configuration section will appear 

below it. 

 

4. Scroll down to the Device section and 

click the button with 3 dots, to the right 

of “S/N” field. This will perform a scan 

and automatically populate the S/N and 

Path fields. 

5. By default “Check Shock Log” is 

unchecked and “Manage Automatically” 

is checked. 

6. Select the drop down next to 

“Parameters Template” and choose 

Mars1417V. 

7. Finally, click on the Utility button to 

open the iDetector interface. 

 

 

Note: after clicking on Utility, the Maven 

software will shutdown 

communication between the panel 

and the Ultra UAI software and 

close, and then iDetector software 

will launch automatically as a popup 

window and begin communication 

with the panel. Settings inside the 

panel can then be changed or panel 

calibrated. 
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4.7 iDetector Interface 

After clicking the Utility button under the 

panel’s Device settings, the iDetector interface 

window will open. 

4.7.1 Trigger Mode Configuration 

The ViZion DR+ 1417V2 wireless panel should 

always be set to FreeSync trigger mode. 

1. Click to highlight DEFAULT under the 

name column and then click the 

Connect button. 

 

 

Warning: before exiting iDetector, DO 

NOT CLICK THE RED X in the top 

right corner, without first going to 

the Home tab, to click Close, and 

to select the Override option. 

 

2. The Acquire tab is selected by default 

when you first connect to the panel in 

iDetector. Click on the Detector tab. 

 

3. On the Detector tab, confirm that Trigger 

mode is set to TriggerMode_FreeSync. 

If it is already set, skip to the next 

section for Wi-Fi configuration of the 

panel. 

4. If the panel was in a different mode, 

change it to TriggerMode_FreeSync.  

5. Click Write and wait for the “State” at 

the bottom to change back to Ready 

highlighted in green. 

6. Click Write ROM and wait for the “State” 

at the bottom to change back to Ready 

highlighted in green and verify that the 

“Message” at the bottom of the screen 

shows success for the action. 

 

 

Note: the ViZionDREXAP 1417V2 

wireless panel needs to always be 

configured in FreeSync trigger 

mode in order to function properly 

in the Ultra UAI software. The panel 

exposure is achieved when dose is 

sensed by the AED sensor in the 

panel. FreeSync opens an 

exposure window for an infinite time 

period, when the panel is activated 

(when clicking the Acquire button in 

Ultra UAI or when using the 

generator hand switch with an 

interfaced generator). 
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Select 1 of the 2 following wireless methods: 

4.7.2 Wi-Fi Configuration in Client Mode 

(Recommended connection method) 

1. Within the Detector tab, click on the 

Wifi tab and select Client mode. 

2. Click Add button and enter the following 

info in the popup dialog box fields: 

• SSID = ViZionDREXAP 

• Key = 12345678 

3. Then click Apply button. 

 

4. Click Read Config button, and then 

click Write Config button to save the 

wifi setting into panel’s ROM memory. 

 

5. Wait for the “State” at the bottom to 

change back to Ready highlighted in 

green and verify “Message” at the 

bottom of the screen shows success. 

4.7.3 Wi-Fi Configuration in AP Mode 

(Alternative connection method) 

1. Within the Detector tab, click on the 

Wifi tab and select AP mode. 

2. Click Add button and configure the 

fields with the following info: 

• SSID = enter the serial number for 

the panel. (It is printed on the bar 

code label on the back of the panel) 

• Key = 12345678 

• Security = Wifi_WPA_WPA2_PSK 

• Frequency = Wifi_Freq_5GHz 

• Country = Wifi_Country_US 

• Band = Wifi_Band_HT20 

• Channel = Wifi_Chnl_157 

3. Click Read Config button, and then 

click Write Config button to save the 

wifi settings into panel’s ROM memory. 

 

4. Wait for the “State” at the bottom to 

change back to Ready highlighted in 

green and verify “Message” at the 

bottom of the screen shows success. 

 

Note: continue to next section for Panel 

Calibration, if needed. Or if you are 

ready to exit at this time, skip to 

Section 4.7.9 for instructions on 

Exiting iDetector software, in order 

to properly sync the new changes 

with Ultra UAI. 
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4.7.4 Panel Calibration Setup 

1. Select the Acquire tab in iDetector.  

 

2. Uncheck the Defect, Gain, and Offset 

checkboxes in that order.  

 

 

Note: during the calibration, please do not 

move the detector once calibration 

has been started and keep Link 

cable connected to the detector. 

 

 

 

 

3. Select the Calibrate tab, check the 

radio button for PostOffset, and click 

the Start Generate Templates button. 

 

The Calibration wizard will open into a new 

window, presenting the Welcome screen. 

4. Set X-ray environment:  

• Tube SID = 50” or higher (at least 

greater than 47”). 

• No Collimation = open collimator 

blades at least 1” past the edges of 

the panel on all sides. 

• No Grid = remove any grid or 

pressure grid cover. 

• No Objects = remove any objects 

from the surface of the panel. 

5. Click the arrow in the top right corner 

labeled Start the journey of 

Calibration. 
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6. Click Skip, in the top right corner, at the 

Generator Parameter Learning screen 

 

7. Click Skip, in the top right corner, at the 

Offset Calibration screen. 

 

4.7.5 Panel Gain Calibration 

 

Note: the Gain Calibration screen 

requires 5 exposures. The left-hand 

side of the screen tells you the 

suggested kV and mAs to use for 

the current exposure. The right-

hand side of the screen is divided 

into 5 blank gain exposure frame 

icons. Each exposure frame is 

numbered sequentially, with the kV 

to use noted next to each one. A 

green box surrounds the current 

exposure frame. 

 

8. Set your techniques to 70kV / 4.7 mAs 

and take your first exposure. 

 

 

Note: after taking an exposure, the 

current gain exposure frame will still 

be surrounded in green. It will either 

have a green checkmark, if it was 

successful, or a yellow exclamation 

point, if it was not within 100 +/-  of 

the expected center average of 

7000. 

 

9. If the exposure was NOT acceptable 

(message in yellow), adjust your mAs up 

or down, click the Prep button, and take 

another exposure.  

10. If the exposure was acceptable 

(message in green), click the Next 

button to move to the next frame. 
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11. After taking all 5 gain exposures, click 

the Back button if you want to retake 

any previous exposures, then click Prep 

and retake the exposure. Otherwise, if 

you are satisfied with all exposures, 

click the Next button in the top right 

corner. 

 

12. Wait for the Gain Map Generation to 

complete and then click Next. 

 

 

 

 

 

 

 

 

4.7.6 Panel Defect Calibration 

 

Note: the Defect Calibration screen 

requires 19 exposures. The left-

hand side of the screen tells you the 

suggested kV and mAs to use for 

the current exposure. The right-

hand side of the screen is divided 

into 19 blank defect exposure frame 

icons. Each exposure frame is 

numbered sequentially, with the kV 

to use noted next to each one. A 

green box surrounds the current 

exposure frame. 

 

13. Set your techniques to 70kV / 1.1 mAs 

and take your first exposure. 

 

 

Note: after taking the first exposure, the 

current defect exposure frame will 

still be surrounded in green. It will 

either have a green checkmark, if it 

was successful, or a yellow 

exclamation point, if it was not 

within 100 +/-  of the expected 

center average of 1000. 
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14. If the exposure was NOT acceptable 

(message in yellow), adjust mAs up or 

down, click the Prep button, and take 

another exposure.  

 

15. If the exposure was acceptable 

(message in green), click the Next 

button to move to the next frame. 

 

16. Set your techniques to 40kV / 4mAs 

and take your second exposure. 

 

17. If the exposure was acceptable, click 

Next to move to the next frame. 

 

18. Set your techniques to 120kV / 1.2mAs 

and take your third exposure. 

 

19. If the exposure was acceptable, click 

Next to move to the next frame. 
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20. Set your techniques to 70kV / 7mAs 

and take your fourth exposure. 

 

21. If the exposure was acceptable, click 

Next to move to the next frame. 

 

22. Continue to take exposures with 

techniques set to 70kV / 7mAs for the 

remaining frames (5-19). 

 

 

23. After taking all 19 defect exposures, 

click the Back button if you want to 

retake any previous exposures, then 

click Prep and retake the exposure. 

Otherwise, if you are satisfied with all 

exposures, click the Next button in the 

top right corner. 

 

24. Wait for the Defect Map Generation to 

complete and then click Next. 

 

25. Calibration is complete. Close the 

window by clicking X in top right corner. 
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4.7.7 Download the Calibration Files to the 

Panel 

After closing the Calibration window, you will be 

back where you left off, at the iDetector 

Calibrate tab. Now we need to download the 

new calibration files to the panel.  

1. Within the Calibrate tab, click on the 

Gain tab, then click the ReadStatus 

button. 

 

2. Highlight Index 1, then click the 

SelectFile button. This will change the 

Index 1 status to enable. 

3. Click the DownloadFile button, and 

then click the Path button from the 

popup window. 

 

 

 

 

4. Browse to the 

C:\opal\data\KGxxxxxxxxxxx\Correct 

\Default folder and select the 

gain_2304x2800.gn file and click Open. 

 

Note: if the gain file does not appear, 

verify the file type dropdown is set 

to gain files(*.gn). 

 

 

5. Type 1 in the FileIndex field and then 

click OK. 

 

6. After the gain file has been downloaded 

to the panel. Click OK. 
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7. Within the Calibrate tab, click on the 

Defect tab, then click the ReadStatus 

button. 

 

8. Highlight Index 1, then click the 

SelectFile button. This will change the 

Index 1 status to enable. 

9. Click the DownloadFile button, and 

then click the Path button from the 

popup window. 

 

 

 

 

 

 

 

 

10. Browse to the 

C:\opal\data\KGxxxxxxxxxxx\Correct 

\Default folder and select the 

defect_2304x2800.gn file. Click Open. 

 

Note: if the defect file does not appear, 

verify the file type dropdown is set 

to defect files(*.dft). 

 

 

11. Type 1 in the FileIndex field and then 

click OK. 

 

12. After the defect file has been 

downloaded to the panel. Click OK. 
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4.7.8 Re-enabling the Calibration Operation 

Options 

13. Select the Acquire tab and check the 

Offset, Gain and Defect checkboxes in 

that order.  

 

14. Check the radio buttons for 

HWPostOffset, HWGain and 

HWDefect. 

 

 

 

 

 

 

 

 

 

4.7.9 Closing iDetector 

It’s important to close iDetector properly, in 

order to sync the changes made in iDetector 

with Ultra UAI. 

15. Select the Home tab, and click the 

Close button.  

 

16. Select Override Config. 

 

 

17. Disconnect the Link cable from both 

ends and store it in a secure place, for 

future reconfiguration purposes. Mobile 

techs should store the Link cable in 

each van, so it is available when 

needed. 
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Note: if you configured the panel for 

Client mode, go back to Section 

3.2.2 and follow the instructions for 

configuring the wireless adapter 

and installing the TP-Link AP. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


